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ASP.NET 5 Documentation


Attention

ASP.NET 5 is being renamed to ASP.NET Core 1.0. Read more [https://blogs.msdn.microsoft.com/webdev/2016/02/01/an-update-on-asp-net-core-and-net-core/].




Note

This documentation is a work in progress. Topics marked with a 🔧 are placeholders that have not been written yet. You can track the status of these topics through our public documentation issue tracker [https://github.com/aspnet/docs/issues]. Learn how you can contribute [https://github.com/aspnet/Docs/blob/master/CONTRIBUTING.md] on GitHub. Help shape the scope and focus of the ASP.NET content by taking the ASP.NET 5 Documentation Survey [https://docs.asp.net/en/latest/contribute/docs-survey.html].




Topics



	Getting Started
	Installing ASP.NET 5 On Windows




	Installing ASP.NET 5 On Mac OS X




	Installing ASP.NET 5 On Linux




	Choosing the Right .NET For You on the Server








	API [https://docs.asp.net/projects/api]

	Tutorials
	Your First ASP.NET 5 Web App Using Visual Studio




	Your First ASP.NET 5 Application on a Mac




	Create an ASP.NET 5 web app in Visual Studio Code [https://azure.microsoft.com/documentation/articles/web-sites-create-web-app-using-vscode/]

	Building your first MVC 6 application
	Getting started with ASP.NET MVC 6




	Adding a controller

	Adding a view




	Adding a model




	Working with SQL Server LocalDB




	Controller methods and views




	Adding Search




	Adding a New Field




	Adding Validation




	🔧 Examining the Details and Delete methods





	Building Your First Web API with MVC 6




	🔧 Creating Backend Services for Native Mobile Applications

	🔧 Create a New NuGet Package with DNX

	Publish to an Azure Web App using Visual Studio

	ASP.NET 5 on Nano Server




	ASP.NET 5 and Azure Service Fabric [https://azure.microsoft.com/en-us/documentation/articles/service-fabric-add-a-web-frontend/]





	Conceptual Overview
	Introduction to ASP.NET 5




	Introducing .NET Core




	DNX Overview




	🔧 Introduction to NuGet

	Understanding ASP.NET 5 Web Apps








	Fundamentals
	Application Startup




	Middleware




	Working with Static Files




	Routing




	Diagnostics




	🔧 Localization

	Configuration




	Logging




	🔧 File Providers

	Dependency Injection




	Working with Multiple Environments




	Managing Application State




	Servers




	Request Features




	OWIN








	MVC
	🔧 Overview of ASP.NET MVC

	Models
	Model Binding




	🔧 Model Validation

	🔧 Formatting

	🔧 Custom Formatters





	Views
	🔧 Razor Syntax

	🔧 Dynamic vs Strongly Typed Views

	🔧 HTML Helpers

	Tag Helpers
	Introduction to Tag Helpers




	Authoring Tag Helpers




	🔧 Advanced Tag Helpers





	🔧 Partial Views

	Injecting Services Into Views




	View Components




	🔧 Creating a Custom View Engine

	🔧 Building Mobile Specific Views





	Controllers
	Controllers, Actions, and Action Results




	🔧 Routing to Controller Actions

	🔧 Error Handling

	🔧 Filters

	Dependency Injection and Controllers




	🔧 Testing Controller Logic

	Areas




	🔧 Working with the Application Model









	Testing
	Unit Testing




	Integration Testing








	.NET Execution Environment (DNX)
	DNX Overview




	Creating a Cross-Platform Console App with DNX




	Working with DNX Projects




	🔧 Compilation

	🔧 Loaders

	🔧 Services

	Using Commands




	🔧 Servicing and Updates

	🔧 Design Time Host

	🔧 Diagnosing Project Dependency Issues

	🔧 Create a New NuGet Package with DNX

	🔧 Migrating an Existing NuGet Package Project

	🔧 Global.json Reference

	🔧 Project.json Reference





	Working with Data
	Getting Started with ASP.NET 5 and Entity Framework 6




	Getting Started With ASP.NET 5 and Entity Framework 7 [http://docs.efproject.net/en/latest/platforms/aspnetcore/getting-started.html]

	Azure Storage
	Adding Azure Storage by Using Visual Studio Connected Services [https://azure.microsoft.com/documentation/articles/vs-azure-tools-connected-services-storage/]

	Get Started with Azure Blob storage and Visual Studio Connected Services [https://azure.microsoft.com/documentation/articles/vs-storage-aspnet5-getting-started-blobs/]

	Get Started with Queue Storage and Visual Studio Connected Services [https://azure.microsoft.com/documentation/articles/vs-storage-aspnet5-getting-started-queues/]

	How to Get Started with Azure Table Storage and Visual Studio Connected Services [https://azure.microsoft.com/documentation/articles/vs-storage-aspnet5-getting-started-tables/]









	Client-Side Development
	Using Gulp




	Using Grunt




	Manage Client-Side Packages with Bower




	Building Beautiful, Responsive Sites with Bootstrap




	Knockout.js MVVM Framework




	Using Angular for Single Page Applications (SPAs)




	Styling Applications with Less, Sass, and Font Awesome




	Bundling and Minification




	🔧 Working with a Content Delivery Network (CDN)

	🔧 Responsive Design for the Mobile Web

	🔧 Introducing TypeScript

	Building Projects with Yeoman








	Mobile
	🔧 Responsive Design for the Mobile Web

	🔧 Building Mobile Specific Views

	🔧 Creating Backend Services for Native Mobile Applications





	Publishing and Deployment
	Publishing to IIS




	🔧 Publishing to a Windows Virtual Machine on Azure

	Publishing to an Azure Web App with Continuous Deployment




	Publish to a Docker Image [https://azure.microsoft.com/documentation/articles/vs-azure-tools-docker-hosting-web-apps-in-docker/]

	🔧 How to Customize Publishing

	Publishing to IIS with Web Deploy using Visual Studio 2015




	How Web Publishing In Visual Studio Works

	Publish to an Azure Web App using Visual Studio

	Publish to a Linux Production Environment








	Hosting
	HTTP Platform Handler




	Directory Structure

	Application Pools




	Servicing




	Data Protection








	Security
	Authentication
	Introduction to ASP.NET Identity




	Enabling authentication using external providers




	Account Confirmation and Password Recovery with ASP.NET Identity




	Two-factor authentication with SMS using ASP.NET Identity




	🔧 Supporting Third Party Clients using OAuth 2.0

	Using Cookie Middleware without ASP.NET Identity




	Azure Active Directory
	Integrating Azure AD Into an ASP.NET 5 Web App [http://azure.microsoft.com/documentation/samples/active-directory-dotnet-webapp-openidconnect-aspnet5]

	Calling a ASP.NET 5 Web API From a WPF Application Using Azure AD [http://azure.microsoft.com/documentation/samples/active-directory-dotnet-native-aspnet5]

	Calling a Web API in an ASP.NET 5 Web Application Using Azure AD [https://azure.microsoft.com/en-us/documentation/samples/active-directory-dotnet-webapp-webapi-openidconnect-aspnet5/]









	Authorization
	Introduction




	Simple Authorization

	Role based Authorization




	Claims-Based Authorization




	Custom Policy-Based Authorization




	Dependency Injection in Requirement Handlers

	Resource Based Authorization




	View Based Authorization

	Limiting identity by scheme




	🔧 Authorization Filters





	Data Protection
	Introduction




	Getting Started with the Data Protection APIs

	Consumer APIs
	Consumer APIs Overview




	Purpose Strings

	Purpose hierarchy and multi-tenancy

	Password Hashing

	Limiting the lifetime of protected payloads




	Unprotecting payloads whose keys have been revoked








	Configuration
	Configuring Data Protection




	Default Settings




	Machine Wide Policy




	Non DI Aware Scenarios





	Extensibility APIs
	Core cryptography extensibility




	Key management extensibility




	Miscellaneous APIs








	Implementation
	Authenticated encryption details.




	Subkey Derivation and Authenticated Encryption




	Context headers




	Key Management




	Key Storage Providers




	Key Encryption At Rest




	Key Immutability and Changing Settings

	Key Storage Format




	Ephemeral data protection providers





	Compatibility
	Sharing cookies between applications.




	Replacing <machineKey> in ASP.NET 4.5.1












	Safe Storage of Application Secrets




	🔧 Enforcing SSL

	🔧 Anti-Request Forgery

	🔧 Preventing Open Redirect Attacks

	🔧 Preventing Cross-Site Scripting

	Enabling Cross-Origin Requests (CORS)








	Performance
	🔧 Measuring Application Performance

	Caching
	In Memory Caching




	Working with a Distributed Cache




	Response Caching




	🔧 Output Caching









	Migration
	Migrating From ASP.NET MVC 5 to MVC 6




	Migrating Configuration From ASP.NET MVC 5 to MVC 6




	Migrating Authentication and Identity From ASP.NET MVC 5 to MVC 6




	Migrating From ASP.NET Web API 2 to MVC 6




	Migrating HTTP Modules to Middleware








	Contribute
	ASP.NET Contributing Guide [https://github.com/aspnet/Home/blob/dev/CONTRIBUTING.md]

	ASP.NET Docs Contributing Guide [https://github.com/aspnet/Docs/blob/master/CONTRIBUTING.md]

	ASP.NET Docs Style Guide




	ASP.NET 5 Documentation Survey












Related Resources


	.NET Core Documentation [https://dotnet.github.io]

	Entity Framework [http://docs.efproject.net]

	WebHooks [http://docs.asp.net/projects/aspnetwebhooks]






Contribute

The documentation on this site is the handiwork of our many contributors [https://github.com/aspnet/docs/contributors].
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Installing ASP.NET 5 On Windows

By Rick Anderson [https://twitter.com/RickAndMSFT], Steve Smith [http://ardalis.com], Daniel Roth [https://github.com/danroth27]

This page shows you how to install ASP.NET 5 on Windows. To run ASP.NET 5 apps on IIS, see Publishing to IIS.


In this article:


	Install ASP.NET 5 with Visual Studio

	Install ASP.NET 5 from the command-line

	Related Resources






Install ASP.NET 5 with Visual Studio

The easiest way to get started building applications with ASP.NET 5 is to install the latest version of Visual Studio 2015 (including the free Community edition).


	Install Visual Studio 2015 [https://go.microsoft.com/fwlink/?LinkId=532606]




Be sure to specify that you want to include the Microsoft Web Developer Tools.

[image: ../_images/web-dev-tools.png]




	Install ASP.NET 5 [https://go.microsoft.com/fwlink/?LinkId=627627].




This will install the latest ASP.NET 5 runtime and tooling.



	Enable the ASP.NET 5 command-line tools. Open a command-prompt and run:

dnvm upgrade










This will make the default .NET Execution Environment (DNX) active on the path.



	On Windows 7 and Windows Server 2008 R2 you will also need to install the Visual C++ Redistributable for Visual Studio 2012 Update 4 [https://www.microsoft.com/en-us/download/confirmation.aspx?id=30679].



You are all set up and ready to write your first ASP.NET 5 application!




Install ASP.NET 5 from the command-line

You can also install ASP.NET 5 from the command-line. There are a few steps involved, since we’ll need to install and configure the environment in which ASP.NET runs, the .NET Execution Environment (DNX). To install DNX, we need one more tool, the .NET Version Manager (DNVM).


Install the .NET Version Manager (DNVM)

Use .NET Version Manager to install different versions of the .NET Execution Environment (DNX).

To install DNVM open a command prompt and run the following:

@powershell -NoProfile -ExecutionPolicy unrestricted -Command "&{$Branch='dev';iex ((new-object net.webclient).DownloadString('https://raw.githubusercontent.com/aspnet/Home/dev/dnvminstall.ps1'))}"





Once this step is complete you should be able to run dnvm and see some help text.




Install the .NET Execution Environment (DNX)

The .NET Execution Environment (DNX) is used to build and run .NET projects. Use DNVM to install DNX for the full .NET Framework or for .NET Core (see Choosing the Right .NET For You on the Server).

To install DNX for .NET Core:


	Use DNVM to install DNX for .NET Core:

dnvm upgrade -r coreclr









To install DNX for the full .NET Framework:


	Use DNVM to install DNX for the full .NET Framework:

dnvm upgrade -r clr









By default DNVM will install DNX for the full .NET Framework if no runtime is specified.






Related Resources


	Your First ASP.NET 5 Web App Using Visual Studio

	Fundamentals
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Installing ASP.NET 5 On Mac OS X

By Daniel Roth [https://github.com/danroth27], Steve Smith [http://ardalis.com], Rick Anderson [https://twitter.com/RickAndMSFT]


Sections:


	Install ASP.NET 5 with Visual Studio Code

	Install ASP.NET 5 from the command-line

	Related Resources






Install ASP.NET 5 with Visual Studio Code

The easiest way to get started building applications with ASP.NET 5 is to install the latest version of Visual Studio Code.


	Install Mono [http://www.mono-project.com/docs/getting-started/install/mac/] for OS X (required by Visual Studio Code).

	Install Visual Studio Code [https://go.microsoft.com/fwlink/?LinkID=534106]

	Install ASP.NET 5 for Mac OS X [https://go.microsoft.com/fwlink/?LinkId=703940]



You are all set up and ready to write your first ASP.NET 5 application on a Mac!




Install ASP.NET 5 from the command-line

You can also install ASP.NET 5 from the command-line. There are a few steps involved, since we’ll need to install and configure the environment in which ASP.NET runs, the .NET Execution Environment (DNX). To install DNX, we need one more tool, the .NET Version Manager (DNVM).


Install the .NET Version Manager (DNVM)

To install DNVM:


	Run the following curl command:

curl -sSL https://raw.githubusercontent.com/aspnet/Home/dev/dnvminstall.sh | DNX_BRANCH=dev sh && source ~/.dnx/dnvm/dnvm.sh







	Run dnvm list to show the DNX versions installed



	Run dnvm to get DNVM help





The .NET Version Manager (DNVM) is used to install different versions of the .NET Execution Environment (DNX) on OS X.




Install the .NET Execution Environment (DNX)

The .NET Execution Environment (DNX) is used to build and run .NET projects. Use DNVM to install DNX for Mono [http://mono-project.com] or .NET Core (see Choosing the Right .NET For You on the Server).

To install DNX for .NET Core:


	Use DNVM to install DNX for .NET Core:

dnvm upgrade -r coreclr









To install DNX for Mono:


	Install Mono [http://www.mono-project.com/docs/getting-started/install/mac/] for OS X. Alternatively you can install Mono via Homebrew [http://brew.sh/].



	Use DNVM to install DNX for Mono:

dnvm upgrade -r mono









By default DNVM will install DNX for Mono if no runtime is specified.


Note

Restoring packages using DNX on Mono may fail with multiple canceled requests. You may be able to work around this issue by setting MONO_THREADS_PER_CPU to a larger number (2000).








Related Resources


	Your First ASP.NET 5 Application on a Mac

	Fundamentals
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Installing ASP.NET 5 On Linux

By Daniel Roth [https://github.com/danroth27]


In this article


	Install using prebuild binaries

	Installing on Ubuntu 14.04

	Installing on CentOS 7

	Using Docker

	Related Resources






Install using prebuild binaries

Prebuild binaries for ASP.NET 5 are available (.tar.gz [https://go.microsoft.com/fwlink/?LinkId=703941]) and can be installed as appropriate based on your system configuration.

Alternatively you can use the .NET Version Manager (DNVM) to install ASP.NET 5 as described below.

For either method of installation you will need to install the prerequisites for your specific distribution as described in the following sections.




Installing on Ubuntu 14.04

The following instructions were tested using Ubuntu 14.04. Other versions of Ubuntu and other Debian based distros are unlikely to work correctly.


Install the .NET Version Manager (DNVM)

Use the .NET Version Manager (DNVM) to install different versions of the .NET Execution Environment (DNX) on Linux.


	Install unzip and curl if you don’t already have them:

sudo apt-get install unzip curl







	Download and install DNVM:

curl -sSL https://raw.githubusercontent.com/aspnet/Home/dev/dnvminstall.sh | DNX_BRANCH=dev sh && source ~/.dnx/dnvm/dnvm.sh









Once this step is complete you should be able to run dnvm and see some help text.




Install the .NET Execution Environment (DNX)

The .NET Execution Environment (DNX) is used to build and run .NET projects. Use DNVM to install DNX for Mono [http://mono-project.com] or .NET Core (see Choosing the Right .NET For You on the Server).

To install DNX for .NET Core:


	Install the DNX prerequisites:

sudo apt-get install libunwind8 gettext libssl-dev libcurl4-openssl-dev zlib1g libicu-dev uuid-dev







	Use DNVM to install DNX for .NET Core:

dnvm upgrade -r coreclr









To install DNX for Mono:


	Install Mono [http://www.mono-project.com/docs/getting-started/install/linux/#debian-ubuntu-and-derivatives] via the mono-complete package.



	Ensure that the ca-certificates-mono package is also installed as noted [http://www.mono-project.com/docs/getting-started/install/linux/#notes] in the Mono installation instructions.



	Use DNVM to install DNX for Mono:

dnvm upgrade -r mono









By default DNVM will install DNX for Mono if no runtime is specified.


Note

Restoring packages using DNX on Mono may fail with multiple canceled requests. You may be able to work around this issue by setting MONO_THREADS_PER_CPU to a larger number (ex. 2000).






Install libuv

Libuv [https://github.com/libuv/libuv] is a multi-platform asynchronous IO library that is used by Kestrel, a cross-platform HTTP server for hosting ASP.NET 5 web applications.

To build libuv you should do the following:

sudo apt-get install make automake libtool curl
curl -sSL https://github.com/libuv/libuv/archive/v1.8.0.tar.gz | sudo tar zxfv - -C /usr/local/src
cd /usr/local/src/libuv-1.8.0
sudo sh autogen.sh
sudo ./configure
sudo make
sudo make install
sudo rm -rf /usr/local/src/libuv-1.8.0 && cd ~/
sudo ldconfig






Note

make install puts libuv.so.1 in /usr/local/lib, in the above commands ldconfig is used to update ld.so.cache so that dlopen (see man dlopen) can load it. If you are getting libuv some other way or not running make install then you need to ensure that dlopen is capable of loading libuv.so.1.








Installing on CentOS 7

The following instructions were tested using CentOS 7.  Other versions of CentOS or other Red Hat based distros are unlikely to work correctly.


Install the .NET Version Manager (DNVM)

Use the .NET Version Manager (DNVM) to install different versions of the .NET Execution Environment (DNX) on Linux.


	Install unzip if you don’t already have it:

sudo yum install unzip







	Download and install DNVM:

curl -sSL https://raw.githubusercontent.com/aspnet/Home/dev/dnvminstall.sh | DNX_BRANCH=dev sh && source ~/.dnx/dnvm/dnvm.sh









Once this step is complete you should be able to run dnvm and see some help text.




Install the .NET Execution Environment (DNX)

The .NET Execution Environment (DNX) is used to build and run .NET projects. Use DNVM to install DNX for Mono [http://mono-project.com] (see Choosing the Right .NET For You on the Server).


Note

DNX support for .NET Core is not available for CentOS, Fedora and derivative in this release, but will be enabled in a future release.



To install DNX for Mono:


	Install Mono [http://www.mono-project.com/docs/getting-started/install/linux/#centos-fedora-and-derivatives] via the mono-complete package.



	Ensure that the ca-certificates-mono package is also installed as noted [http://www.mono-project.com/docs/getting-started/install/linux/#notes] in the Mono installation instructions.



	Use DNVM to install DNX for Mono:

dnvm upgrade -r mono









By default DNVM will install DNX for Mono if no runtime is specified.


Note

Restoring packages using DNX on Mono may fail with multiple canceled requests. You may be able to work around this issue by setting MONO_THREADS_PER_CPU to a larger number (ex. 2000).






Install Libuv

Libuv [https://github.com/libuv/libuv] is a multi-platform asynchronous IO library that is used by Kestrel, a cross-platform HTTP server for hosting ASP.NET 5 web applications.

To build libuv you should do the following:

sudo yum install automake libtool wget
wget http://dist.libuv.org/dist/v1.8.0/libuv-v1.8.0.tar.gz
tar -zxf libuv-v1.8.0.tar.gz
cd libuv-v1.8.0
sudo sh autogen.sh
sudo ./configure
sudo make
sudo make check
sudo make install
ln -s /usr/lib64/libdl.so.2 /usr/lib64/libdl
ln -s /usr/local/lib/libuv.so.1.0.0 /usr/lib64/libuv.so










Using Docker

The following instructions were tested with Docker 1.8.3 and Ubuntu 14.04.


Install Docker

Instructions on how to install Docker can be found in the Docker Documentation [https://docs.docker.com/installation/].




Create a Container

Inside your application folder, you create a Dockerfile which should looks something like this:

# Base of your container
FROM microsoft/aspnet:latest

# Copy the project into folder and then restore packages
COPY . /app
WORKDIR /app
RUN ["dnu","restore"]

# Open this port in the container
EXPOSE 5000
# Start application
ENTRYPOINT ["dnx","-p","project.json", "web"]





You also have a choice to use CoreCLR or Mono. At this time the microsoft/aspnet:latest repository is based on Mono. You can use the Microsoft Docker Hub [https://hub.docker.com/r/microsoft/aspnet/] to pick a different base running either an older version or CoreCLR.




Run a Container

When you have an application, you can build and run your container using the following commands:

docker build -t yourapplication .
docker run -t -d -p 8080:5000 yourapplication










Related Resources


	Your First ASP.NET 5 Application on a Mac

	Fundamentals
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Choosing the Right .NET For You on the Server

By Daniel Roth [https://github.com/danroth27]

ASP.NET 5 is based on the .NET Execution Environment (DNX), which supports running cross-platform on Windows, Mac and Linux. When selecting a DNX to use you also have a choice of .NET flavors to pick from: .NET Framework (CLR), .NET Core (CoreCLR) or Mono [http://mono-project.com]. Which .NET flavor should you choose? Let’s look at the pros and cons of each one.


.NET Framework

The .NET Framework is the most well known and mature of the three options. The .NET Framework is a mature and fully featured framework that ships with Windows. The .NET Framework ecosystem is well established and has been around for well over a decade. The .NET Framework is production ready today and provides the highest level of compatibility for your existing applications and libraries.

The .NET Framework runs on Windows only. It is also a monolithic component with a large API surface area and a slower release cycle. While the code for the .NET Framework is available for reference [http://referencesource.microsoft.com/] it is not an active open source project.




.NET Core

.NET Core 5 is a modular runtime and library implementation that includes a subset of the .NET Framework. .NET Core is supported on Windows, Mac and Linux. .NET Core consists of a set of libraries, called “CoreFX”, and a small, optimized runtime, called “CoreCLR”. .NET Core is open-source, so you can follow progress on the project and contribute to it on GitHub [https://github.com/dotnet].

The CoreCLR runtime (Microsoft.CoreCLR) and CoreFX libraries are distributed via NuGet [https://www.nuget.org]. Because .NET Core has been built as a componentized set of libraries you can limit the API surface area your application uses to just the pieces you need. You can also run .NET Core based applications on much more constrained environments (ex. Windows Server Nano [http://blogs.technet.com/b/windowsserver/archive/2015/04/08/microsoft-announces-nano-server-for-modern-apps-and-cloud.aspx]).

The API factoring in .NET Core was updated to enable better componentization. This means that existing libraries built for the .NET Framework generally need to be recompiled to run on .NET Core. The .NET Core ecosystem is relatively new, but it is rapidly growing with the support of popular .NET packages like JSON.NET, AutoFac, xUnit.net and many others.

Developing on .NET Core allows you to target a single consistent platform that can run on multiple platforms.

Please see Introducing .NET Core for more details on what .NET Core has to offer.




Mono

Mono [http://mono-project.com] is a port of the .NET Framework built primarily for non-Windows platforms. Mono is open source and cross-platform. It also shares a similar API factoring to the .NET Framework, so many existing managed libraries work on Mono today. Mono is not a platform supported by Microsoft; however, it is a good proving ground for cross-platform development while cross-platform support in .NET Core matures.




Summary

The .NET Execution Environment (DNX) and .NET Core make .NET development available to more scenarios than ever before. DNX also gives you the option to target your application at existing available .NET platforms. Which .NET flavor you pick will depend on your specific scenarios, timelines, feature requirements and compatibility requirements.
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Tutorials



	Your First ASP.NET 5 Web App Using Visual Studio




	Your First ASP.NET 5 Application on a Mac




	Create an ASP.NET 5 web app in Visual Studio Code [https://azure.microsoft.com/documentation/articles/web-sites-create-web-app-using-vscode/]

	Building your first MVC 6 application
	Getting started with ASP.NET MVC 6




	Adding a controller

	Adding a view




	Adding a model




	Working with SQL Server LocalDB




	Controller methods and views




	Adding Search




	Adding a New Field




	Adding Validation




	🔧 Examining the Details and Delete methods





	Building Your First Web API with MVC 6




	🔧 Creating Backend Services for Native Mobile Applications
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Your First ASP.NET 5 Web App Using Visual Studio

By Erik Reitan [https://github.com/Erikre]

In this tutorial, you’ll create a simple web app using ASP.NET 5. The app stores data in a SQL database using Entity Framework (EF) and uses ASP.NET MVC to support the basic CRUD operations (create, read, update, delete).


Sections:


	Prerequisites

	Create a new ASP.NET 5 project

	Entity Framework

	Create a data model and scaffolding

	Using data migrations to create the database

	Adding navigation

	Run the web app locally

	Publish the web app to Azure App Service

	Additional Resources






Prerequisites

Before you start, make sure that you have the followed the getting started steps for Installing ASP.NET 5 On Windows. This tutorial assumes you have already installed Visual Studio 2015 [http://go.microsoft.com/fwlink/?LinkId=532606] and the latest ASP.NET 5 [http://go.microsoft.com/fwlink/?LinkId=627627] runtime and tooling.


Note

For additional information about installing ASP.NET 5 on other platforms, see Getting Started.






Create a new ASP.NET 5 project

Start Visual Studio 2015. From the File menu, select New > Project.

Select the ASP.NET Web Application project template. It appears under Installed > Templates > Visual C# > Web. Name the project ContosoBooks and click OK.

[image: ../_images/02-new-project.png]
In the New ASP.NET Project dialog, select Web Application under ASP.NET 5 Preview Templates. Also, make sure the Host in the cloud checkbox is not selected and click OK.

[image: ../_images/03-web-site-template.png]

Note

Do not change the authentication method. Leave it as the default Individual User Accounts for this tutorial.




Running the default app

Once Visual Studio finishes creating the app, run the app by selecting Debug -> Start Debugging. As an alternative, you can press F5.

It may take time to initialize Visual Studio and the new app. Once it is complete, the browser will show the running app.

[image: ../_images/05-browser-runapp.png]
After reviewing the running Web app, close the browser and click the “Stop Debugging” icon in the toolbar of Visual Studio to stop the app.




Review the project

In Visual Studio, the Solution Explorer window lets you manage files for the project. The web application template that you used to create this web app adds the following basic folder structure:

[image: ../_images/06-solution-explorer.png]
Visual Studio creates some initial folders and files for your project. The primary files that you should be familiar with include the following:







	File name
	Purpose




	project.json
	The presence of a project.json file defines a .NET Execution Environment (DNX) project. It is the project.json file that contains all the information that DNX needs to run and package your project. For additional details, including the project.json file schema, see Working with DNX Projects.


	global.json
	Visual Studio uses this file to configure the project.


	appsettings.json
	This file allows you to include additional project information, such as connection string values. For more information, see  Configuration.


	Startup.cs
	The Startup class provides the entry point for an application. The Startup class must define a Configure method, and may optionally also define a ConfigureServices method, which will be called when the application is started. For more information, see Application Startup.


	Index.cshtml
	This view contains the HTML for the default page of the view.


	_Layout.cshtml
	This view contains common HTML for multiple pages of the web app.


	HomeController.cs
	This controller contains the classes that handle incoming browser requests, retrieve model data, and then specify view templates that return a response to the browser.





In addition to these files the project is also setup to handle authenticating  users. To learn more about authentication and identity in ASP.NET 5 see Authentication. For a more complete overview of the structure of an ASP.NET 5 project see Understanding ASP.NET 5 Web Apps. In this tutorial we will focus on adding functionality to our app using MVC and EF.




Understanding MVC

This project uses MVC. MVC stands for Model-View-Controller. MVC is a pattern for developing applications that are well architected, testable, and easy to maintain. MVC-based applications contain:



	Models: Classes that represent the data of the application  and that use validation logic to enforce business rules for that data.

	Views: Template files that your application uses to dynamically  generate HTML responses.

	Controllers: Classes that handle incoming browser requests, retrieve model data, and then specify view templates that return a response to the browser.









Understanding .NET Core

.NET Core 5 is a modular runtime and library implementation that includes a subset of the .NET Framework. .NET Core 5 has been designed for Windows, Linux and OS X. It consists of a set of libraries, called “CoreFX”, and a small, optimized runtime, called “CoreCLR”. .NET Core is open-source, so you can follow progress on the project and contribute to it on GitHub. For more information, see Choosing the Right .NET For You on the Server.






Entity Framework

Entity Framework [http://docs.efproject.net] (EF) is an object-relational mapping (ORM) framework. It lets you work with relational data as objects, eliminating most of the data-access code that you’d usually need to write. Using EF, you can issue queries using LINQ, then retrieve and manipulate data as strongly typed objects. LINQ provides patterns for querying and updating data. Using EF allows you to focus on creating the rest of your application, rather than focusing on the data access fundamentals.

Open the project.json file. In the dependencies section, you will see the following lines related to EF:

  "dependencies": {
    "EntityFramework.Commands": "7.0.0-rc1-final",
    "EntityFramework.MicrosoftSqlServer": "7.0.0-rc1-final",





These lines show that you can issue EF commands from the command window and that the EF NuGet package is included with your project.




Create a data model and scaffolding

Entity Framework supports a development paradigm called Code First. Code First lets you define your data models using classes. A class is a construct that enables you to create your own custom types by grouping together variables of other types, methods and events. You can map classes to an existing database or use them to generate a database. In this tutorial, you’ll begin by creating the entity classes that define the data models for the Web application. Then you will create a context class that manages the entity classes and provides data access to the database. You will then configure EF and populate the database.


Create entity classes

The classes you create to define the schema of the data are called entity classes. If you’re new to database design, think of the entity classes as table definitions of a database. Each property in the class specifies a column in the table of the database. These classes provide a lightweight, object-relational interface between object-oriented code and the relational table structure of the database.

The Web app will have two new entities:


	Book

	Author



You will define a class for each in the Models folder within Solution Explorer. Each class will define the


Note

You can put model classes anywhere in your project. The Models folder is just a convention.



Right-click the Models folder and select Add > New Item. In the Add New Item dialog, select the Class template. In the Name edit box, type “Author.cs” and click OK.

[image: ../_images/15-add-new-item.png]
Replace the default code with the following code:

using System.Collections.Generic;
using System.ComponentModel.DataAnnotations;

namespace ContosoBooks.Models
{
    public class Author
    {
        [ScaffoldColumn(false)]
        public int AuthorID { get; set; }
        [Required]
        [Display(Name = "Last Name")]
        public string LastName { get; set; }

        [Display(Name = "First Name")]
        public string FirstMidName { get; set; }

        public virtual ICollection<Book> Books { get; set; }
    }
}





Repeat these steps to add another class named Book with the following code:

using System.ComponentModel.DataAnnotations;

namespace ContosoBooks.Models
{
    public class Book
    {
        [ScaffoldColumn(false)]
        public int BookID { get; set; }
        [Required]
        public string Title { get; set; }

        public int Year { get; set; }
        [Range(1, 500)]
        public decimal Price { get; set; }

        public string Genre { get; set; }

        [ScaffoldColumn(false)]
        public int AuthorID { get; set; }

        // Navigation property
        public virtual Author Author { get; set; }
    }
}





To keep the app simple, each book has a single author. The Author property provides a way to navigate the relationship from a book to an author. In EF, this type of property is called a navigation property. When EF creates the database schema, EF automatically infers that AuthorID should be a foreign key to the Authors table.




Add Scaffolding

Scaffolding saves you time and coding effort by automatically generating the starting point for your application’s CRUD (Create, Read, Update and Delete) operations. Starting from a simple model class, and, without writing a single line of code, you will create two controllers that will contain the CRUD operations related to books and authors, as well as the all the necessary views.

To add a scaffolding, right-click the Controllers folder in Solution Explorer. Select Add –> New Scaffolded Item.

[image: ../_images/15a-scaffold-menu.png]

Note

If you don’t see the New Scaffolded Item option, make sure you have created the project using Individual User Accounts.



From the Add Scaffold dialog box, select MVC 6 Controller with views, using Entity Framework, then click the Add button.

[image: ../_images/15b-add-scaffold-db.png]
Next, in the Add Controller dialog box, set the model class dropdown to Book (ContosoBooks.Models). Also, set the data context class to ApplicationDbContext (ContosoBooks.Models). Make sure the Generate views checkbox is checked. Then click the Add button.

[image: ../_images/15c-book-controller.png]
As you can see in the above image, the Add Controller dialog box gives you the opportunity to select options for generating the controller and views.

This scaffold creates the code that provides a controller and a set of views. The views provide the UI and code to create, read, update, delete, and list data from the database.

Repeat the above scaffolding steps to create an Author controller and related views. Use the Author (ContosoBooks.Models) model class and the ApplicationDbContext (ContosoBooks.Models) data context class as shown in the following image.

[image: ../_images/15d-author-controller.png]
In the Solution Explorer you’ll see that the new controllers were added within the Controller folder and new views were created within the Views folder.

[image: ../_images/15e-updated-solution-explorer.png]



Add sample data

Rather than entering several sample records by hand, you will add code that will by used to populate your database. Add a class named SampleData in the Models folder with the following code:

using Microsoft.Data.Entity;
using Microsoft.Extensions.DependencyInjection;
using System;
using System.Linq;

namespace ContosoBooks.Models
{
    public static class SampleData
    {
        public static void Initialize(IServiceProvider serviceProvider)
        {
            var context = serviceProvider.GetService<ApplicationDbContext>();
            context.Database.Migrate();
            if (!context.Book.Any())
            {
                var austen = context.Author.Add(
                    new Author { LastName = "Austen", FirstMidName = "Jane" }).Entity;
                var dickens = context.Author.Add(
                    new Author { LastName = "Dickens", FirstMidName = "Charles" }).Entity;
                var cervantes = context.Author.Add(
                    new Author { LastName = "Cervantes", FirstMidName = "Miguel" }).Entity;

                context.Book.AddRange(
                    new Book()
                    {
                        Title = "Pride and Prejudice",
                        Year = 1813,
                        Author = austen,
                        Price = 9.99M,
                        Genre = "Comedy of manners"
                    },
                    new Book()
                    {
                        Title = "Northanger Abbey",
                        Year = 1817,
                        Author = austen,
                        Price = 12.95M,
                        Genre = "Gothic parody"
                    },
                    new Book()
                    {
                        Title = "David Copperfield",
                        Year = 1850,
                        Author = dickens,
                        Price = 15,
                        Genre = "Bildungsroman"
                    },
                    new Book()
                    {
                        Title = "Don Quixote",
                        Year = 1617,
                        Author = cervantes,
                        Price = 8.95M,
                        Genre = "Picaresque"
                    }
                );
                context.SaveChanges();
            }
        }
    }
}





You wouldn’t put this sample data class into production code, but it’s okay for this sample app scenario.

Next, in Solution Explorer, open the Startup.cs file. Add the following line of code at the end of the Configure method:

SampleData.Initialize(app.ApplicationServices);





Notice in ConfigureServices the app calls Configuration["Data:DefaultConnection:ConnectionString"] to get the database connection string. During development, this setting comes from the appsettings.json file. When you deploy the app to a production environment, you set the connection string in an environment variable on the host. If the Configuration API finds an environment variable with the same key, it returns the environment variable instead of the value that is in appsettings.json.




Build the web application

To make sure that all the classes and changes to your Web application work, you should build the application.

From the Build menu, select Build Solution.

The Output window is displayed, and if all went well, you see a succeeded message.

[image: ../_images/19-vs-build-output.png]
If you run into an error, re-check the above steps. The information in the Output window will indicate which file has a problem and where in the file a change is required. This information will enable you to determine what part of the above steps need to be reviewed and fixed in your project.


Note

Before running the app, you must first create the database using the data migrations.








Using data migrations to create the database

Data migrations in EF are used to perform model updates throughout your entire application. By initially using data migrations to create your database, you can modify your database after the model has changed with simple steps. This will allow you to build and maintain your web app more efficiently. The alternative to data migrations, where model or schema changes are required after the database has been created, involves recreating your entire database.

Open a Command Prompt in the project directory (ContosoBooks/src/ContosoBooks).


Note

To open the Command Prompt, you can right-click the Windows start button and select Command Prompt from the menu.



To find the project directory, in Visual Studio you can right-click the project name (ContosoBooks) in the Solution Explorer and select Open Folder in File Explorer. Copy your project path from File Explorer so you can copy it to the Command Prompt. For example, enter the following from the Command Prompt to change directories:

cd C:\Projects\ContosoBooks\src\ContosoBooks






Note

Make sure that you have navigated to the ContosoBooks folder within the src folder.



Run each of the following commands from the Command Prompt:

dnu restore
dnx ef migrations add Initial
dnx ef database update






Note

If dnu restore is not a recognized command, you may have missed a prerequisite step (or part of a prerequisites step) at the beginning of this topic. See Install the .NET Version Manager (DNVM) and Install the .NET Execution Environment (DNX).



Running dnu restore will restore the package dependencies specified in your project.json file. The ef command is specified in the project.json file of your project. For more information about dnvm, dnu, and dnx, see DNX Overview.

The add Initial command creates a migration named “Initial” that adds code to the project, allowing EF to update the database schema. The update command creates the actual database. After you run this command, the Migrations folder of your project will be updated as follows:

[image: ../_images/16-migrations.png]

Note

For general EF command help, enter the following in the command window: dnx ef -?.



Also, you will be able to view the newly created database within SQL Server Object Explorer.

[image: ../_images/16a-database.png]



Adding navigation

Update the navigation for the web app. From Solution Explorer, open the Views/Shared/_Layout.cshtml file. Find the following markup:

<li><a asp-controller="Home" asp-action="Index">Home</a></li>
<li><a asp-controller="Home" asp-action="About">About</a></li>
<li><a asp-controller="Home" asp-action="Contact">Contact</a></li>





Replace the above markup with the following markup:

<li><a asp-controller="Books" asp-action="Index">Books</a></li>
<li><a asp-controller="Authors" asp-action="Index">Authors</a></li>





The above changes will add a link to view Books and a link to view Authors. You created each of these views when you added scaffolding to the project.


Build the web application

To make sure that all the classes and changes to your Web app work, you should build the app again.

From the Build menu, select Build Solution.






Run the web app locally

Run the app now to see how you can view all of the products or just a set of products limited by category.

In the Solution Explorer, right-click the project name and select View -> View in Browser. As an alternative, you can press the F5 key.

The browser will open and show the web app. Click on the Books link at the top of the page.

[image: ../_images/19a-running-app.png]
Close the browser and click the “Stop Debugging” icon in the toolbar of Visual Studio to stop the app.




Publish the web app to Azure App Service

In Solution Explorer of Visual Studio, right-click on the project and select Publish.


[image: ../_images/20-vs-publish.png]



In the Publish Web window, click on Microsoft Azure Web Apps and log into your Azure subscription.


[image: ../_images/21-vs-publishwebdb.png]



Make sure you are signed in to Azure with your Microsoft account, then click New to create a new Web app in Azure.


[image: ../_images/22-vs-selectexistingdb.png]



Enter a unique site name, and select an app service plan, resource group, and region. Also, choose to create a database server, along with a database username and password. If you’ve created a database server in the past, use that. When you’re ready to continue, click Create.


[image: ../_images/23-vs-createwebappdb.png]



On the Connection tab of the Publish Web window, click Publish.


[image: ../_images/24-vs-publishwebdb-target.png]



You can view the publishing progress in either the Output window or the Azure App Service Activity window within Visual Studio.


[image: ../_images/25-vs-webpubactivity.png]



When publishing to Azure is complete, your web app will be displayed in a browser running on Azure.


[image: ../_images/26-browserazure.png]



For additional publishing information, see Publishing and Deployment.




Additional Resources


	Introduction to ASP.NET 5

	Understanding ASP.NET 5 Web Apps

	Fundamentals
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Your First ASP.NET 5 Application on a Mac

By Daniel Roth [https://github.com/danroth27], Steve Smith [http://ardalis.com], Rick Anderson [https://twitter.com/RickAndMSFT]

ASP.NET 5 is cross-platform; you can develop and run web apps on Mac OS X, Linux and Windows. This article will show you how to write your first ASP.NET 5 application on a Mac.


Sections:


	Setting Up Your Development Environment

	Scaffolding Applications Using Yeoman

	Developing ASP.NET Applications on a Mac With Visual Studio Code

	Running Locally Using Kestrel

	Publishing to Azure

	Additional Resources






Setting Up Your Development Environment


	Install ASP.NET on your Mac with OS X

	Check which DNX version you have active by running dnvm list






Scaffolding Applications Using Yeoman

Follow the instruction in Building Projects with Yeoman to create an MVC 6 project.




Developing ASP.NET Applications on a Mac With Visual Studio Code


	Start Visual Studio Code



[image: ../_images/vscode-welcome.png]

Note

If Visual Studio Code is not installed, see Install ASP.NET on your Mac with OS X.




	Tap File > Open and navigate to your ASP.NET app



[image: ../_images/file-open.png]
From a Terminal / bash prompt, run dnu restore to restore the project’s dependencies. Alternately, you can enter command shift p and then type >d as shown:

[image: ../_images/dnx_restore.png]
This will allow you to run commands directly from within Visual Studio Code, including dnu restore and any commands defined in the project.json file.

At this point, you should be able to host and browse to this simple ASP.NET web application, which we’ll see in a moment.

This empty project template simply displays “Hello World!”. Open Startup.cs in Visual Studio Code to see how this is configured:

[image: ../_images/vscode-startupcs.png]
If this is your first time using Visual Studio Code (or just Code for short), note that it provides a very streamlined, fast, clean interface for quickly working with files, while still providing tooling to make writing code extremely productive.

In the left navigation bar, there are four icons, representing four viewlets:


	Explore

	Search

	Git

	Debug



The Explore viewlet allows you to quickly navigate within the folder system, as well as easily see the files you are currently working with. It displays a badge to indicate whether any files have unsaved changes, and new folders and files can easily be created (without having to open a separate dialog window). You can easily Save All from a menu option that appears on mouse over, as well.

The Search viewlet allows you to quickly search within the folder structure, searching filenames as well as contents.

Code will integrate with Git if it is installed on your system. You can easily initialize a new repository, make commits, and push changes from the Git viewlet.

[image: ../_images/vscode-git.png]
The Debug viewlet supports interactive debugging of applications. Currently only node.js and mono applications are supported by the interactive debugger.

Finally, Code’s editor has a ton of great features. You should note right away that several using statements are underlined, because Code has determined they are not necessary. Note that classes and methods also display how many references there are in the project to them. If you’re coming from Visual Studio, Code includes many of the keyboard shortcuts you’re used to, such as command k c to comment a block of code, and command k u to uncomment.




Running Locally Using Kestrel

The sample is configured to use Kestrel [https://docs.asp.net/en/latest/fundamentals/servers.html#kestrel] for the web server. You can see it configured in the project.json file, where it is specified as a dependency and as a command.

	 1
 2
 3
 4
 5
 6
 7
 8
 9
10
11
12
13
14
15
16
17
18
19
20
21
22
23
24
25
26
27
28
29
30
31
32

	 {
   "version": "1.0.0-*",
   "userSecretsId": "aspnet5-MyWebApp-a1b07c55-6f20-4aaf-9852-9c964160a00c",
   "compilationOptions": {
     "emitEntryPoint": true
   },
   "tooling": {
     "defaultNamespace": "MyWebApp"
   },

   "dependencies": {
     "EntityFramework.Commands": "7.0.0-rc1-final",
     // Dependencies deleted for brevity.
     "Microsoft.AspNet.Server.Kestrel": "1.0.0-rc1-final"
   },

   "commands": {
     "web": "Microsoft.AspNet.Server.Kestrel",
     "ef": "EntityFramework.Commands"
   },

   // Markup deleted for brevity.

   "scripts": {
     "prepublish": [
       "npm install",
       "bower install",
       "gulp clean",
       "gulp min"
     ]
   }
 }








	Run the dnx web command to launch the app

	Navigate to localhost:5000:



[image: ../_images/hello-world.png]

	To stop the web server enter Ctrl+C.






Publishing to Azure

Once you’ve developed your application, you can easily use the Git integration built into Visual Studio Code to push updates to production, hosted on Microsoft Azure [http://azure.microsoft.com].


Initialize Git

Initialize Git in the folder you’re working in. Tap on the Git viewlet and click the Initialize Git repository button.

[image: ../_images/vscode-git-commit.png]
Add a commit message and tap enter or tap the checkmark icon to commit the staged files.

[image: ../_images/init_commit.PNG]
Git is tracking changes, so if you make an update to a file, the Git viewlet will display the files that have changed since your last commit.




Initialize Azure Website

You can deploy to Azure Web Apps directly using Git.


	Create a new Web App [https://tryappservice.azure.com/] in Azure. If you don’t have an Azure account, you can create a free trial [http://azure.microsoft.com/en-us/pricing/free-trial/].

	Configure the Web App in Azure to support continuous deployment using Git [http://azure.microsoft.com/en-us/documentation/articles/web-sites-publish-source-control/].



Record the Git URL for the Web App from the Azure portal:

[image: ../_images/azure-portal.png]

	In a Terminal window, add a remote named azure with the Git URL you noted previously.


	git remote add azure https://Rick-Anderson@rickmac.scm.azurewebsites.net:443/rickmac.git





	Push to master.


	git push azure master to deploy.


[image: ../_images/git-push-azure-master.png]









	Browse to the newly deployed web app.





[image: ../_images/azure.png]





Additional Resources


	Visual Studio Code [https://code.visualstudio.com]

	Building Projects with Yeoman

	ASP.NET Fundamentals
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Building your first MVC 6 application



	Getting started with ASP.NET MVC 6




	Adding a controller

	Adding a view




	Adding a model




	Working with SQL Server LocalDB




	Controller methods and views




	Adding Search




	Adding a New Field




	Adding Validation




	🔧 Examining the Details and Delete methods
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